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Introduction

FullPaint is the next generation in Macintosh painting
environments, a powerful yet easy-to-use program which
picks up where MacPaint™ left off. With FullPaint you'll be
able to create and manipulate images in ways you've only
dreamed of until now.

FullPaint is 100% compatible with MacPaint and documents
from both programs may be interchanged freely. This
program is also compatible with Switcher™ (the minimum
Switcher configuration for FullPaint is 384K), digitizing
tablets, and digitizing cameras. In addition, all standard
Macintosh programs can interchange information with
FullPaint through the clipboard or scrapbook.

For on-screen reference once you have entered the program,

choose On-Line Help from the % menu, or click once on
the "?" on the right side of all document title bars, or press the

3 and "H" keys simultaneously.

Ann Arbor Softworks wishes to extend special thanks to Bill
Atkinson for pointing the way.

MacPaint and Switcher are trademarks of Apple Computer.






Getting Started

This chapter is an overview of some basic FullPaint
functions for creating, editing and manipulating
documents. If you already have experience working with
MacPaint, you may want to skip this section. On the other
hand, if you are new to the Macintosh, you should refer to
the owner's manual which came with your machine.

The skills you will learn in this chapter will be applicable
to most paint documents you'll be creating in the future.
Once you have completed this section, you can use your
newly acquired skills as a basis to explore other tools and
commands.

+ Getting Started With FullPaint

Turn the Macintosh on, and a blinking icon (picture) will
appear. This indicates that your Mac is ready for you to
insert the FullPaint program disk. After you have inserted
the disk, the Macintosh Finder screen will appear with the
FullPaint disk icon in the upper right corner of the screen.

The first thing you need to do is open the program disk.
The techiques employed in opening the disk are identical
in principal to other Macintosh operations that you will be
performing: first select an item, then choose what you
wish to do with that item.

When opening the disk, this "select and choose"
sequence may be done in either of two ways: you can
click once with the mouse button on the disk icon in order
to select it (when an icon is selected, it's color inverts to
black), then move the pointer onto the File menu title,



hold down the mouse button and
New Folder 3N | move the pointer down the menu,
releasing the button when it is
Deind resting on top of the Open
Close command; or you can click twice
............................................................. in rapid succession ("double-
Get Info %] click") on the disk icon.
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Page Setup
Print Catalog

When the disk is opened, a window displaying the
contents of the FullPaint disk will appear. You should see
icons representing the FullPaint program, the System
Folder, LaserPaint (an accessory program), and the
Sample Paintings Folder, which contains some
documents previously created with FullPaint.
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Opening the Program

You can now open the FullPaint program by utilizing
either of the techniques used to open the FullPaint disk.
(You can also open an existing document, such as those
in the Sample Paintings Folder, with the same
technique.) It will take a few seconds for the program to
load and then the screen will look like this.
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Opening the FullPaint program presents you with a new,
blank document ready for painting.

Using the Palettes

Now that you have a blank document to work with, try
creating something. Move the cursor over to the tool
palette and click once on the pencil icon. When you
move the cursor back into the document window, it will
change into a pencil. Once the pencil has appeared,
hold down the mouse button and move the pencil around
the window. The pencil will draw a thin line as long as
the mouse button is held down and the pencil is in the
document window.



Using the same technigues you used to select the pencil
tool, select the paintbrush tool and try working with it.
Make a few "strokes" across the page, then move the
cursor up to the Goodies menu. When the paintbrush
moves outside of the active window, it will change back
into the arrow-shaped cursor.

« Changing the Brush and the Pattern

Choose the Brush Shape command from the Goodies
menu. A display window of several different brush
shapes will appear on the screen, with the current brush
shape outlined by a dark rectangle. To change the
current brush shape, click on any of the other shapes in
the display window. To keep the current brush shape,
click on it, or press the Return key.
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Clicking on any brush shape in the display window will
close the window. If you have chosen a new shape, try
painting with it to see how the different brush shape looks
on the page. Next, move the cursor down to the pattern
palette at the bottom of the screen. The pattern palette
displays all the potential pattern selections, with the
currently selected pattern appearing in the slightly larger



rectangle to the far left of the palette. Place the cursoron
any of the patterns in the palette and click once. The
pattern you clicked on becomes the current pattern.
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When you move back into the active window and start
painting again, the paintbrush will paint in the pattern you
just selected. The current pattern is also utilized by the
spraypaint tool. The spraypaint tool works in the same

@ fashion as the paintbrush, but applies a lighter and more
diffuse 'coat’ of paint.

L7 If you 're not happy with something you've created, you
can use the eraser tool to white out any offending areas
of the painting. Double-clicking on the eraser will erase
the entire window.

You may want to take some time now to experiment with
various tools and patterns.

« Using the Menus
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3 which you have been using:
FatBits #F | move the cursor onto the menu
] gige "o 4 oW the mouse button
Show Pages ... and move down the list of

Edit Pattern ... commands until you reach the
Brush Shape ... one you want, then release the
mouse button.

fo-acas

Brush Mirrors ...
Ruler Units ...

-------------------------------------------------------------

You will notice that some of these
commands are followed by a

Preferences ... | 3 key - letter key combination.




This indicates a 'keystroke option,' or in other words, a
way to select that particular command by simultaneously
pressing those two keys rather than going up to the menu
bar with the mouse. The commands that appear in a dark
typeface are currently active and can be selected.

vin D

When you're ready to quit working on this document, go
to the File menu and choose Save. You will be
presented with a dialog box asking you to name the
document. Enter in any name, such as "Document #1,"
and then click in the Save button. The Save button will
not be activated until you enter a name for the document
(the name can be as short as one letter or one symbol).
If you make a typing mistake, simply use the Backspace
key to back up and try again.
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Save Document As: . FullPaint™
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Document #1| T

Save | [ Cancel | . ( brive )
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You can also select the disk on which you wish to save
the document. The current disk name is displayed in the
upper right corner of the dialog box. If you are working
with more than one disk drive, you can click in the Drive
button to change the current disk, and then save the
document to a disk in a different drive. If you are working
with a hard disk, clicking in the Drive button will advance
you to the next volume on the hard disk; or you can click
in the Eject button and insert a different disk for the
document to be saved to. Clicking in Cancel will return
you to the document window without saving the
document.
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Once you have named and saved a document, you can
save any subsequent changes to it by reselecting the
Save command. Generally speaking, it's a good idea to
save your work approximately every fifteen minutes, so
that you do not lose all your work in case of a power
failure or other unhappy event.

| D ment

Once you have saved a document, you can then close it
by either going to the File menu and choosing Close or
by clicking in the small white 'close’ box located in the

title bar at the upper left corner of the document window.

If you attempt to close a document you have maade
changes to without saving it first, you will be prompted by
a dialog box asking you if you want to save the changes
you have made. Click in the Yes button if you want to
save the document with the changes you've made. Click
No if you want to return the document to the state it was
in before any changes were made and then close it.
Click Cancel to remove the dialog box and go back to
the document.

B Save changes to 'untitlied’ before
closing?

Yes

g
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+ Opening a New Document From Within the
Program

Once you are operating within the program, you can open
a new document by choosing New from the File menu.
A blank document will appear, ready for painting.

« Opening an Existing Document From Within the
Program

To open an existing document, go to the File menu and
choose Open. A dialog box will appear in the center of
the screen listing all previously created paint documents
on the current disk in alphabetical order. The current disk
title is listed in the upper right corner of the dialog box.
You can change the current disk by clicking in the Drive
button if you have a second drive, or by clicking in the
Eject button and inserting a different disk in the drive. If
you are working with a hard disk, clicking in the Drive
button will advance you to the next volume on the hard
disk.

I Riphie's Bar T,

Bamboo Eyes ( I]penk_]; FullPaint™

Document #1

Eject

[ Cancel ] Drive

>

The only documents listed at this time will be the sample
paintings included with the disk, and "Document #1,"
which you just created. To open one of these documents,
either click on a document name (try "Alphie's Bar") to
select it and then click in the Open button, or double-click
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on the document name. The "Alphie's Bar" document will
appear on screen.

In the future, when you have many more documents in
the directory, you can scan the titles in one of three ways:
clicking on one of the arrows located at the top and
bottom of the scrollbar will move the list one title at a time;
clicking in the gray area above or below the white
scrollbox moves the list seven titles at a time; clicking
inside the scrollbox itself and dragging it allows you to
move through the list in large or small increments.

« Saving Two Copies of a Document

If you have made changes to an existing document and
wish to save the document both in it's previous state and
with the latest changes, you can use the Save As
command from the File menu. This will save two copies
of the document. You will be prompted for a name for the
new document which contains the latest changes.

Quitting the Program

When you are ready to quit the program, choose Quit
from the File menu. This command will exit you from the
program and return you to the Finder. If you choose Quit
before closing a document, you will be prompted by a
dialog box, asking you if you wish to save the changes
you have made.

' Save changes to 'Bamboo Eyes’
before quitting?

Yes |

l NO ]‘: Dl?fncel —]
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By holding down the Option and Shift keys while
choosing Quit, you can bypass this dialog box and return
directly to the Finder without being asked if you want to
save the changes.

« Working In the Finder

Once you have returned to the Finder, open the Sample
Paintings folder. Two icons will appear in the folder - two
paintings which were included when the disk was
shipped. Instead of beginning with a blank document
every time, you can open the FullPaint program and go
directly to one or more of these existing documents. To
open an existing document, use either of the opening
techniques you performed on the FullPaint program
earlier.

While you are working in the Finder, take a minute to go
up to the menu bar and look at a couple of other
commands which you will probably find useful in the
future. Under the File menu, the New Folder,
Duplicate and Eject commands are all important to,
Know.

Once you've created a few documents of your own,
folders are a big help in staying organized. Choosing
New Folder will bring up an icon with the title Empty
Folder. By clicking on document icons, dragging them on
top of a folder icon and then releasing the mouse button,
you can deposit documents into the folder. You can
name folders or documents on the desktop by clicking on
a title to select it and then typing the new title.
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The Duplicate command allows you to create exact
replicas of documents or folders. Selecting a document
such as "Alphie's Bar" and then choosing Duplicate will
create a copy of the document with the title, surprisingly
enough, of "Copy of Alphie's Bar."

E

Alphie's Bar | ﬂ

Copy of Alphie's Bar

Dragging a document icon from one disk onto another
one will also create a copy of the document, with the copy
going onto the other disk in this case, and retaining it's
original title, without the "Copy of . . ." in front of it.

When you are ready to put away FullPaint and shut down
your Mac, use the Shut Down command from the
Special menu. Choosing the Eject command from the
File menu will eject the FullPaint disk and ready the Mac
for a different program disk to be inserted.

You should now be familiar with some of FullPaint's basic
functions. The following chapters describe further
capabilities. As always, don't be afraid to experiment with
FullPaint.
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Creating Images The Macintosh screen display is made up of thousands of
individual picture elements, or pixels, and FullPaint gives
you absolute control over each of these tiny dots. The
creation of images basically involves turning on or off
individual pixels and arranging them to form patterns and
paintings.

Painting

« The Paintbrush

= ﬁ The paintbrush tool is activated by a single click on it's
icon, as are all other tools on the palette. Once the

paintbrush has been selected, you can paint by clicking

and/or dragging anywhere within the the active window.

Holding down the Shift key while you are painting
constrains the brush's movement, forcing it to move on

exactly horizontal or vertical lines. Holding down the 3
key while painting causes the paintbrush to lay down a
transparent layer of paint, one which will allow any black
areas of an underlying image to show through.

+ Choosing the Shape of the Paintbrush

The shape of the brush may be changed by choosing
Brush Shape from the Goodies menu. FullPaint offers
32 different brush shapes to choose from, and the current
brush shape is always outlined by a dark rectangle.

17
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To keep the current shape active, click once on it, or
press the Return key. To change the current brush
shape, simply click on the desired new shape Clicking
on any brush shape will close the brush shape display
window. You can also create entirely new brush shapes
by editing existing ones; this feature is detailed in the
Advanced Capabilities section.

+ The Spraypaint Tool

The spraypaint tool can also be used for painting. The
spraypaint tool lays down a finer, more diffuse layer of
paint than the paintbrush. Making only one pass with the
spraypaint tool will result in a fine, mist-like layer of paint,
while making several passes increases the density of the
paint.
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Holding down the Shift key while you are painting
constrains the spraypaint tool's movement, forcing it to
move on exactly horizontal or vertical lines. Holding

down the 3 key causes the spraypaint tool to lay down a
transparent layer of paint, one which will allow any black
areas of an underlying image to show through.



Both the paintbrush and the spraypaint use the currently
selected pattern when painting. Changing the current
pattern is detailed in the Patterns sections which follows.

Patterns

The pattern palette near the bottom of the screen displays
all the available patterns. The slightly larger pattern on
the far left is the current pattern. Clicking on any pattern
will select it to be the current pattern.
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By holding down the % key while using the paintbrush
or spraypaint tool, you can paint one pattern over the top
of another, with the top pattern replacing any white pixels
in the underlying pattern. By overlapping different
patterns, you can create intricate shadings and designs.
You can also create entirely new patterns by editing
existing ones; this feature is detailed in the Advanced
Capabilities section.

Drawing

Free-hand drawing of images can be accomplished
through the use of the pencil and the line tool (The
freehand shape tool is also quite useful; this tool is
described in the Shapes and Fills section.).

« The Pencil

7 Clicking on the pencil icon makes it the active tool.

The pencil will normally draw a single-pixel black line.
However, if the pencil point is on a black pixel when you
click the mouse button, that pixel becomes white. If you
keep the mouse button depressed after initially clicking
on a black pixel, the pencil will also turn all other black

19
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pixels it touches in the drawing window to white.

The ability to change the color of individual pixels is a
feature of the pencil which becomes much more powerful
when drawing in FatBits mode. FatBits is a command
from the Goodies menu which presents a magnified
view of the pixels. This feature is discussed in depth later
in this chapter.

- Drawing With the Straight Line Tool

The straight line tool can be used for drawing ruler-
straight black lines at any angle. When you select the
straight line tool, the cursor changes into a crosshairs
while in the active window. You can then draw a straight
line by clicking and dragging the crosshairs. As long as
the mouse button is held down, you can change both the
angle and length of the line. Once the mouse button is
released, though, the angle and length are set.

This tool has advantages over the pencil in certain
situations. The pencil draws in the color opposite that of
the pixel it was over when the mouse button was pressed,
whereas the straight line tool will only draw in black, and
will not invert pixels that are already black. Also, the
pencil draws a fixed, single-pixel wide line, but you can
change the width of the straight line tool by changing the
current line/border width on the tool palette.

Holding down the Option key while using the straight line
tool causes it to to draw in the current pattern. Clicking on
any pattern in the pattern palette makes it the current
pattern.

Using the Shift key in conjunction with the straight line
tool forces, or constrains, the line to be drawn absolutely
vertical, horizontal or on a 45 degree angle. This feature
is especially useful when drawing diagonal lines, as
diagonal lines drawn without the Shift key appear jagged
unless they are drawn on a perfect 45 degree angle.



Shapes and Fills

« Shape Tools

These ten icons in the tool palette represent shapes and
filled shapes which can be drawn with the mouse in the
usual click and drag fashion. Choosing any of the shape
tools will transform the cursor into a crosshairs with
which you can create the shapes. As long as the mouse
button is depressed, the size and shape can be adjusted.
The tools on the left draw hollow shapes; the tools on the
right draw shapes filled with the current pattern.

The icons represent the following shapes:

Draw rectangles.

Draw rectangles with rounded corners.

Q]|U

Draw ovals.

£ Draws freehand lines. The freehand line tool has an
"auto-smoothing" feature which generally makes lines
drawn with it appear smoother than similar lines drawn
with the pencil. In addition, the pencil draws a fixed,
single-pixel wide line, but the width of the straight line tool
can be changed by selecting a different line/border width
in the tool palette.

Also, the pencil draws in the color opposite that of the
pixel it was over when the mouse button was pressed,
whereas the straight line tool will only draw in black, and
will not invert pixels that are already black.

& Draws freehand filled shapes. FullPaint automatically
connects the ends of the freehand line and fills the
constructed shape with the current pattern.

21
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Draws hollow polygons. The beginning and end points
are set by single clicks of the mouse, until the end of the
last side, which is set with a double-click, a single click on
the beginning point, or a click outside the window.

Draws filled polygons. Click once to turn a corner on a
drawing. Double-click or click again at the beginning
point in order to end a drawing and have it filled with the
current pattern.

+ Shape Borders

The border width of all shapes may be changed by
clicking on a different line/border width on the tool palette.
When one of the solid-line borders is selected, the width
of the crosshairs exactly represent the width that the
shape borders will be; when the dotted-line border is
selected, the hollow shape tools will be drawn with a very
thin border while the filled shape tools will be drawn with
no border. The current line/border width is indicated by a
checkmark.

+ Shape Tool Techniques

The top six of the ten tools may be constrained to draw in
perfect proportion by holding down the Shift key in
conjunction while using the tool.

You can create shapes with borders drawn in the current
pattern by holding down the Option key while using the
shape tools.

Holding down the 3 key while using the filled shape
tools draws them transparently, allowing the black pixels
from any underlying image to show through.
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» Filling in Outlined Areas

To fillin any outined area with the currently selected
pattern, click on the paintcan and then click inside the
outlined area. The paintcan will "pour” the current pattern
into the outlined area.

F
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The area to be filled must be completely enclosed. If
there is a gap in the outline, the paint will "leak" through
and fill the surrounding area as well. If this happens,
choose Undo from the Edit menu to undo the fill, then
choose FatBits from the Goodies menu and use the
pencil to fill in any gaps in the outline. Using FatBits is
described later in this chapter.
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It's also possible to fill one pattern on top of another. The
uppermost pattern will 'flow’ through any unbroken
channels in the underlying pattern until it reaches a
barrier. For example if you pour a new pattern into a
section of an existing pattern which is white, the new
pattern will flow until it hits a black-pixel barrier.
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The paintcan is similar to the Fill command in the
Goodies menu (Fill works with the active selection.
Selections are discussed in the chapterof the same
name.), with two major exceptions: the paintcan fills an
area out to the border, while Fill replaces the border as
well; Fill totally covers any underlying image, while the
paintbucket does not obliterate the underlying pattern but
rather flows around any unbordered areas within it.
Clicking in a white area with the paintcan causes the
pattern to fill until it hits black pixels; clicking in a black
area causes the pattern to fill until it hits white pixels.

ext

Text can be inserted at any location in the active window.
Clicking on the text icon activates the text tool . When you
then move the cursor into the active window, it will appear
as an |l-beam until you click on the spot in the window
where you want the text to appear, at which point it will
change into a blinking insertion point.

FullPaint text does not automatically wrap around to the
next line down; when you wish to move down to the next
line, you must hit Return.

« Changing Text

Text may be altered or erased until you click elsewhere in
the window; once you click elsewhere, the text becomes
part of the painting and you can no longer change font,
fontsize or style for that particular piece of text. However,
you can still use other tools or commands on it, just like
any other part of the painting. Using the Grid command
from the Goodies menu (which can also be

implemented by pressing the 3 and "G" keys) places

an invisible grid over the painting and helps you to align
newly placed text with existing text.
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Typing text over an existing image will normally result in a
solid white box enclosing the text. This effect can be

changed in two ways: holding down the 3 key while
placing an insertion point causes the text to be drawn in a
transparent mode which allows the underlying painting to
show through; holding down the Option key while placing
an insertion point or typing a letter causes the text to be
drawn in a color opposite that of the underlying painting.

% File Edit Goodies Windows Font FoniSize Style
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Either of these style changes can also be achieved by

pressing the Enter key in conjunction with either the 3
or Option key.
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« Text Menu Commands

Font, FontSize and Style determine the appearance of
the text and may be changed via their respective menus.
Current selections are indicated by checkmarks.

vheneva
New York
Chicago
Monaco

m

9 point

10
v12

14

18

24

36

48

72

99

vPlain
Bold
fialic
Underline
mtlime

Shadom

RAlign Left
Rlign Middle
Align Right

#P
*B
1
#U
#*0
F*S

L
#M
#R

You can change the font size without going to the menu

bar by holding down the 3 key while pressing either of
the < > keys. Likewise, you can change the font without

going to the menu bar by holding down the 3 and Shift

keys while pressing either of the < > keys.
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FullPaint also provides one custom font size, which can
be specified by choosing Preferences from the
Goodies menu, entering a number between 1 and 127
in the Custom FontSize Selection box, and clicking
OK.

Custom Font Size Selection

FatBits AutoScroll 0K
(<] Mouse Crawl

Cancel

Clicking in the Cancel button will disregard any change
you have made in the custom font size box. Entering 0 as
the custom font size will result in the program defaulting
to 12 point, or the nearest size to that on the disk. The
custom font size will appear as the last item listed on the
FontSize menu, and can be selected from there.

Changing the current Font, FontSize or Style selections
will change everything from the current insertion point
backwards to the last insertion point which was placed.

In order to use a different Font, FontSize or Style in the
same group of text and not lose your insertion point
(which is all important for proper alignment of text), it is
necessary to press the Enter key before making the new
selection. This keeps previous text from being affected by
the change and will type all forthcoming text in the new
selection.



+ Text Tips

While using the text tool, the keystroke shortcut for Undo
is 38 -Z

FontSizes which are outlined on the menu will generally
look much better when printed out, as they are actually
stored on the disk, whereas the non-outlined fontsizes
must be created by the program on demand.

To create letters filled with the current pattern, choose a
large FontSize (24 points or larger) and choose Outline
from the Style menu. Type out your text and then go back
and fill in each letter using the paintcan tool.

Revert, Undo, and the Eraser

Revert, Undo, and the Eraser allow you to experiment
with confidence, knowing you can always return your
document to its previous state.

Choosing Revert from the File menu will erase all
changes made to the document since you last saved it.
Closing the document and then clicking in the No button
when you are asked if you want to save the changes you
have made will give the same result.

The Undo command in the Edit menu will undo the last
event performed with the mouse, whether it be a menu
command or an action executed in the window.

However, clicking the mouse button anywhere on screen,
except for on the menu titles, negates this capability as
that mouse click becomes the new 'last event." Undo can
also be implemented by using the | T | key (in the upper
left corner of the keyboard) or the % and "Z" keys in
conjunction.
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Erasing part or all of a document can be done in a variety
of ways.

Clicking on the eraser tool and then clicking and
dragging in the active window will erase any part of the
painting that the eraser tool passes over. Holding down
the Shift key in conjunction with the eraser will constrain
it's movement, causing it to erase only vertically or
horizontally. The eraser will then only erase in a straight
line, and only in the first direction in which you move it.

The eraser tool is approximately 1/4" square and is often
too large for precise jobs. For more delicate work, first
select the paintbrush tool, then choose Brush Shapes
from the Goodies menu and click on one of the smaller
brush shapes. Finally, go down to the Patterns palette
and select the all-white pattern. You can now use the
small paintbrush to paint white, or erase, small areas of
your document.
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Double-clicking on the eraser tool will erase the entire
active window (if this is done accidentally, simply choose
Undo from the Edit menu).

To erase an entire document, choose ShowPage from
the Goodies menu, then position the pointer outside the
dotted rectangle and drag the image off the page.
ShowPage is detailed further in the Dealing With
Documents chapter.

Choosing the Clear command from the Edit menu will
erase a selected area; selecting an area is detailed in the
Selections chapter.

FatBits

Choosing FatBits from the Goodies menu gives you a
magpnified, "dot by dot" view of a painting. You can also
enter FatBits mode by double-clicking on the pencil icon,
by pressing the # and "F" keys, or by holding down the 3¢
key while clicking in the window with the pencil tool. The
first two methods will place you in FatBits in the area of
the document in which you last painted; the latter two
methods will place you in FatBits in the area of the
document that the cursor currently occupies.
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Any of the techniques used for entering FatBits can also
be used to exit FatBits.

When entering or exiting FatBits, you can continue use of
a tool without interruption by keeping the mouse button

held down while pressing the 3 and "F" keys. This
allows you to continue working with the tool in the same
exact location of the document.

The small rectangle in the upper left-hand corner, called
the ViewBox, presents a normal size image of the
painting and indicates which section of the document you
are currently working in. You can move the ViewBox
anywhere in the active window by clicking on it and
dragging it while holding down the Option key. Clicking
in the ViewBox while the Option key is not held down will
exit you from FatBits.

By using the pencil tool in FatBits you can turn individual
dots on and off; clicking on a black dot will turn it white
and clicking on a white dot will turn it black. All other
tools also work in FatBits.

Choosing Preferences from the Goodies menu will
bring up a display window with a variety of option
preferences. The AutoScroll feature allows you to
automatically access the entire window while in FatBits
mode without having to change tools. If you come to the
edge of the active window while using a tool in FatBits,
the window will automatically "scroll" across the
document.

I Custom Font Size Selection
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This feature can be implemented by clicking in the
AutoScroll checkbox (when an X appears in the box,
the command is activated) and then clicking OK to close
the window. Clicking again in the checkbox will turn the
feature off.

In addition to this autoscroll feature, the scrollbars and the
hand tool can be used to move around the page while in
FatBits mode. Holding down the Option key while the
pencil tool is active changes the pencil into the hand tool,
enabling you to move around the window without
returning to the tool palette to change tools.
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Dealing
With Documents

Windows

A document is viewed through a "window." Although an
entire paint document measures 8" x 10", only the part of
the document which is visible through the window at any
particular time can be worked on. With FullPaint,
windows can be grown to any size and moved anywhere
on the screen. Additionally, up to four documents can be
open at one time, and their respective windows can be
arranged in any way desired.

The windowing tools at the bottom of the tool palette
represent the three different view modes FullPaint
supports. Clicking once on a windowing tool will select
that view mode. The current view mode is always
underlined.

« Full Screen

The tool on the right represents a full-screen document
view. In Full Screen mode the contents of a document fill
the entire screen - the window's title bar, scroll bars, and
grow icon are not visible. Note that, although the menu

bar isn't visible, menu items with 3 key equivalents are
still available.
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« Full Screen with the Menu Bar

Clicking on the center tool will bring up the full-screen
ED document view, but with a menu bar along the top.
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While in either of the full-screen modes, simultaneously
pressing the & and "A" keys will toggle the menu bar on
and off. Note that this is a short cut for the windowing
tools on the tool palette, which won't be easily accessible
if your palettes are hidden or moved off-screen.
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- Windows on the Desktop

@]
LI

" | Choosing the left icon (which is the default mode)
J presents a windowed view similar to that found in other
Macintosh applications.
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_ ¥ A window's size may be manipulated by using the ‘grow
':}.E. box' in the lower right hand corner of the window. By
clicking in this box and dragging, you can resize the
window to the desired dimensions.

Double-clicking on the window's title bar will
automatically grow the window to the largest size that will
fit on screen and still leave the scrollbars and the title bar
visible. Double-clicking in the title bar again will return
the window to it's previous size. In addition, desk
accessories (such as the scrapbook or clock) may be leit
on screen for visible reference while you are working in
the windowed view.
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Multiple Documentis i

« Opening Documents —

Up to four documents may be open simultaneously,
allowing you to work on multiple documents without
going through the tedious task of saving and closing one
document before opening another.

You can open multiple documents from within the
program by using the New and/or Open commands from
the File menu.

You can open multiple documents when FullPaint is first

run in one of three ways. First, if there are four or less .
documents on the disk, you can choose Select All from

the Edit menu, then choose Open. Second, if the -
documents you wish to open are all clustered together,
you can enclose them all in a selection rectangle by
clicking in the white area next to one of the documents,
dragging across the documents to be selected, and then
either double-clicking on one of the documents or
choosing Open. Third, you can hold down the Shift key
while clicking on various documents, then either double-
click on one or choose Open.

Although FullPaint allows multiple documents (up to four)
to be open simultaneously, only one document is active
at any particular time. When multiple windows are visible
on screen, clicking anywhere in a window's contents or in
it's border makes that particular window the active one.
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« Rearranging Documents
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The Windows menu offers
several ways to arrange
multiple windows on screen.
The first four items in the menu

correspond to the titles of paint

documents that are currently
open; choosing one of these
document titles from the menu
will bring that document to the
front and make it's window the
active window. Note that these

have 3 key equivalents. # and '1' will bring the first
document to the front, 3 and '2' the second, and so on.
This capability is particularly useful in the full-screen
views when only one document is visible at a time.
Choosing a document from the Windows menu or using

the 3 key shortcuts will let you switch documents at

any time.



The Clean Up and Stack Up commands can be used
to arrange multiple windows on the desktop. Choosing
Clean Up causes all open documents to be displayed
without overlap ('tiled') on the desktop, with the currently
active window remaining active.
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Choosing Stack Up causes all open windows to be
layered on top of each other, with the active window on
top and the title bars of the other open documents visible
above. Once again, the currently active window remains
active.
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You can also move a window by clicking anywhere in it's
title bar (which runs along the top of the window), and
dragging the window to the desired location.

——
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Moving and Hiding Palettes

The tool and pattern palettes in FullPaint can be dragged
anywhere on the screen. To drag either palette, move the
cursor to a position anywhere on the palette's border
(outside of the icon boxes) and then click and drag the
palette to the desired position. Note that the cursor
becomes a compass pointer when you are over a
draggable area.

Holding down the Option key while clicking on the
palettes disables the tools and allows you to click
anywhere on the palette in order to drag and reposition it.

Pressing the 3 and "W" keys will clean up the palettes,
returning them to their initial positions. Palettes may be
aimost completely hidden by dragging them off screen;
however, a small piece of the palette must remain on
screen so that it can be dragged back.
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Pressing the keyboard spacebar will hide the palettes
from view; pressing it a second time will bring them back
into view. (While the text tool is in use, this feature is

disabled; pressing the 8 and spacebar in conjunction
will toggle the palettes.) This can also be accomplished
by using the Hide Tools / Show Tools command in

the Windows menu, or by pressing the 3 and "T" keys.
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Moving Around The Page

Although the Macintosh screen is approximately 5 1/2 x 7
inches, the work area available in a FullPaint document is
8 x 10 inches - thus, there is a large amount of the
document off-screen at any given time. Choosing
ShowPages from the Goodies menu allows you to

view the entire document. Double-clicking on the hand
tool in the tool palette will also bring up the ShowPages
display.

ShowPages presents a scaled view of the entire 8 x 10
document, with a gray rectangle surrounding the area
which is currently active and visible in the active window.



* Moving the Active Window on the Page

Clicking and dragging from a position inside the gray will
move the rectangle around on the page, moving the
location of the active window with it. You can move the
gray rectangle in any direction, but not past the edge of
the page.

If you click in the OK button in the lower right hand corner
of the ShowPage display after moving the dotted
rectangle, the new area outlined by the rectangle will
become the visible contents of the active window. By
holding down the Shift key while dragging the rectangle,
you can constrain movement to exact horizontal and
vertical directions.
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« Moving the Painting on the Page

Clicking and dragging in an area gutside the gray
rectangle will drag the entire document page underneath
the window, thereby moving the painting to a new
location on the page. This capability is particularly useful
if you are running out of room for painting in one direction
on the page but have excess room in the opposite
direction.

Clicking in the OK button will return you to your painting,
with the painting shifted to it's new location on the
document page. Once again, you can constrain the
dragging to exact horizontal and vertical movement by
holding down the Shift key.



If you have more than one document open, you can view
them in the ShowPage display by clicking on the Next
or Previous buttons.

Be careful while using ShowPages - if you drag any part
of your painting off the edge of the page and click OK,
you will lose that part of the painting for good. However
until the OK button is clicked, it is still possible to move
the painting back onto the page. Clicking in the Cancel
button will ignore any changes and return you to the
active window in it's previous location.

* Moving Around the Page With the Hand Tool

You can also use the hand icon in the tool palette to
move the visible area of the drawing window over the
document page. You can move the visible area in any
direction until you reach the edge of the page. The hand
tool is particularly useful for quickly accessing areas of
the document that are just a small distance off-screen.

By holding down the Shift key when using the hand tool,
you can constrain movement of the drawing window on
the page to exact horizontal and vertical directions. The
hand can also be utilized without going to the tool palette
by holding down the Option key while the pencil tool is
active.

* Moving Around the Page With the Scrollbars

The scrollbars along the right and bottom edges of each
document window are another means for moving around
the page.

Clicking on the arrows at the ends of a scroll bar will
move the active view of the document one pixel at a time.
Clicking within the scroll bar itself will move the view half
an inch. Clicking and dragging the scroll box allows you
to move to any area of the document.
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Page Position

FullPaint offers a pair of tools to help you achieve
pinpoint accuracy in your paintings.

+ Using the Rulers

Choose Rulers from the Goodies i R R | R

menu and rulers will pop up along
both the upper and left sides of the
active window. While the cursor is
in the window, the twin indicator
bars slide to show you the exact
current position of the mouse. —
When the hand tool or scrollbars
are used to move around the
document, the rulers slide to follow the movement.

N L LN P

|

At the junction of the rulers in the upper left corner of the
document window there is a two letter abbreviation. This
tells you whether the rulers are measuring in inches (in),
centimeters (cm), pixels (px), or picas (pc). To change the
measuring unit, double-click anywhere on the rulers and

a dialog box will appear, asking you for your preference.
You can also bring up this dialog box by selecting Ruler
Units from the Goodies menu.
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 Using the MouseSpot Display

Choosing MouseSpot™ from the A +003 61
Goodies menu brings up a small @ 3 +004 54
three-section display window. The .
upper section of the MouseSpot Ao +000. 24
display tells you the exact position L' ‘

of the cursor in the document, relative [[E=== +001.68

to the upper left corner of the document
page. The position is displayed in the current ruler units:
the default is inches.

The lower two sections of the display indicate the exact
dimensions of the shape or object being drawn: the
middle section presents the measurements on horizontal
and vertical ax'es; the lower section gives the diagonal
measurement.

As with the rulers, distance in the MouseSpot display may
be expressed in terms of inches, centimeters, pixels, or
picas. To change the measuring unit, double-click
anywhere in the MouseSpot display, or select Ruler
Units from the Goodies menu, and a dialog box will
appear, asking you for your preference. Changing the
measuring unit for the MouseSpot display will
automatically change it for the rulers, and vice-versa.
You can move the MouseSpot display window around
the screen by clicking anywhere in the display and
dragging.

The MouseSpot display is a valuable aid for tasks which
demand precision. The size of objects, the distance
between them, and their position on the page are alll
made readily available, allowing you to proportion and
position the elements of your painting with exact detail.
Desktop publishing, drafting, graphic design and
schematic layouts are just a few of the applications made
easier by employing the MouseSpot.
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You can move the mouse in single pixel increments by
enabling the Mouse Crawl™ feature. First choose
Preferences from the Goodies menu, click in the
Mouse Crawl checkbox (When an X appears in the box,
the command is enabled.), and then leave the
Preferences window by clicking OK.

Custom Font Size Selection 62
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Once the command is enabled in the Preferences
window, you can then turn it on and off by locking and
unlocking the Caps Lock key. This features allows you to
perform exact painting and drawing tasks. When the
Caps Lock key is down, all normal mouse movements are
scaled, allowing pinpoint accuracy in the painting. When
the Caps Lock key is up, the mouse behaves normally.

« An Example of Mouse Crawl Usage

Turn Mouse Crawl on before beginning to draw a line or
shape in order to start in the exact location desired. Once
the drawing is started, keep the mouse button held down
and unlock the Caps Lock key to turn off the feature, then
continue drawing out the object. When you near the
completion point of the drawing, press the Caps Lock key
again - while keeping the mouse button held down - and
end your drawing in the exact location desired.
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Printing a Document

To print a document, choose Print Draft or Print ...

from the File menu.

Choosing Print ... brings up a dialog box with several
options. The contents of the dialog box will vary,

depending on whether you have an ImageWriter or

LaserWriter connected to your Macintosh. If both are
connected, you must pick one to be active. To do this,
select Choose Printer from the % menu, click on one
of the printer names, then click in the OK button.

If the ImageWriter is selected, a dialog box similar to this

will appear:

Quality:

(@ Draft
) Fina
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Clicking in the Full Page button will print the entire
document. If part of the document is currently marquee-
selected, clicking in the Selection button will print only
the selection.

Clicking in the Draft button will produce an exact, dot-by-
dot representation of the document; clicking in the Final
button will print a 'smoothed'’ version of the document.
Documents printed out in Final mode will generally look
better than documents printed out in Draft mode.

Clicking in the 100% button will print a normal-size
version of the document; clicking in the 50%, 200%, or
400% buttons will produce a version in the
corresponding reduced or enlarged size. If choosing an
enlarged size causes the image to grow to a size that will
no longer fit on a single page, FullPaint will automatically
print the document on two or more pages.

If the LaserWriter is selected, a dialog box similar to this
will appear:
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The Full Page / Selection and Draft / Final buttons

serve the same function in the LaserWriter dialog box as they
do in the ImageWriter dialog. The Size box will accept any
percentage from 25 to 400, and will print out the document or
selection in a corresponding reduced or enlarged size.

+ Using the LaserPrint Program

You can ‘clean up' a painting before printing on the
LaserWriter by quitting FullPaint, returning to the Finder, and
opening the LaserPrint program. LaserPrint allows you to
divide the painting into either four or sixteen sections and
then manipulate each section on a higher scale of resolution -
150 dots per inch with four sections, 300 dots per inch with
sixteen sections - than the 72 dots per inch you normally see
on screen. Using the Rulers and the MouseSpot helps to
align the borders of the various sections before printing. The
LaserPrint dialog boxes will guide you through the
application.

+ Selecting Print Draft From the File Menu

Choosing Print Draft brings up a dialog box with a Cancel
button and prints an exact dot-by-dot representation of the
entire document. Holding downthe 3 key while choosing
Print Draft produces a printout of the active window. Holding
down the Option key while selecting Print Draft will result in a
printout that is reduced 50% in size. The Option Key can be
used in conjunction with the 3 key to get a reduced
printout of the active window.
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« Printing Tips

By depressing the Caps Lock key and simultaneously

holding down the 3 |, Shift and "4" keys, you can get a
printout of the entire screen, including menu bar, palettes,
and anything else on screen. You can also save any
screen onto disk as a FullPaint document. This is
referred to as saving a screen shot, and is accomplished

by holding down the # |, Shift and "3" keys
simultaneously. Screen shots are automatically stored
numerically beginning with Screen 0.

To print a FullPaint document without entering the
program, simply select the document to be printed from
the Finder by clicking on it once (you can select more
than one document by holding down the Shift key as you
click on successive documents or, if the documents you
wish to print are all clustered together, you can enclose
them all in a selection rectangle by clicking in the white
area next to one of the documents and dragging across
the documents to be selected) and then choose Print
from the File menu.

The Finder will close and a dialog box will open; selected
documents will be printed according to their location on
the desktop - left to right, top to bottom.
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Selecting and Moving Images

The lasso and marquee are extremely useful tools for
selecting and manipulating images.

- Selecting With the Marquee

When you click on the marquee tool, the cursor will
become a crosshairs when over the active window.
Clicking and dragging in the active window will draw a
rectangle bordered by "crawling ants". The marquee may
be resized as long as the mouse button is held down.

You will probably find it easiest to make selections
diagonally, from corner to corner. Everything within the
rectangle, including any white space, will be selected,
and may be manipulated in a variety of ways. But more
on manipulating in a minute.

While the cursor is positioned within the marquee, the
crosshairs will become an arrow, and you can click and
drag the selected image around the window. The
selected image will be 'lifted’ off the page, leaving the rest
of the painting unaffected.
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The area from which the selected image was 'lifted' will
now appear as white space. If you place the selected
image on top of an existing image and deactivate the
marquee, the underlying image will be lost. Clicking in
an area outside of the marquee will deactivate the
marquee.

Double-clicking on the marquee tool will select the entire
active window. Triple-clicking on the marquee tool will
select the entire active document.

+ Selecting With the Lasso

Clicking on the lasso and then clicking and dragging in
the active window will draw a one-pixel wide, free-hand
outline. The line is drawn from the tip of the lasso knot.
Images are selected by enclosing them with the lasso
outline.

When you release the mouse button, the lasso tool will
draw a line connecting the current location with the
beginning of the outline. Only images within the lasso
outline will be selected. After the mouse button is
released, the lasso-drawn outline vanishes and a
crawling ants border appears around the boundary of the
image, indicating that it has been selected.
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The lasso automatically shrinks tight around the object
it encloses.

If any non-bordered white space is included within the
area selected, the lasso will automatically shrink to
exclude the white space and draw tight around the
image. Everything within the tightened outline will be
selected, including white space that is completely
enclosed. To lasso-select white areas of the document,
hold down the Option key while drawing the outline. This
tells the lasso tool not to shrink the selection outline. You
can also lasso-select an image that is completely
bordered by double-clicking on or within the image.

If an object selected with the lasso does not have a
complete border, then the lasso ‘enters' through the holes
in the border and selects only the black pixels. If you then
move or paste the selected image over an existing image,
the black pixels in the underlying image will show

through in the white space of the selected image above.
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While the cursor is positioned inside the outlined image it
will become an arrow, and you can click and drag the
image around the window. The area from which the
selected image was 'lifted’ will now appear as white
space. If you place the selected image on top of an
existing image and deactivate the selection, the image
underneath will be lost. Clicking in an area outside of the
selected image will deactivate the selection outline.

Double-clicking on the lasso icon in the tool palette will
lasso-select the entire active window.

Cut/Copy/Paste

In addition to being moved around the window, a
selected image can also be cut or copied and then
pasted in other documents or programs. Cut, Copy, and
Paste are all located in the Edit menu.

Choosing Cut, or pressing the # and "X" keys, will
erase the selected image from the screen and store itin a
holding area of the Macintosh's memory called the
Clipboard. Choosing Copy, or pressing the 3 and "C"
keys, will leave the selected image on screen and store a
copy on the Clipboard. Only one item can be stored on
the Clipboard at a time; an item that is cut or copied
automatically replaces whatever was previously on the
Clipboard. If you only wish to erase a selected image,
you can use the Clear command from the Edit menu, or
press the Backspace key. Clear erases the selected
image without affecting the contents of the Clipboard.
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« Using the Scrapbook

If you wish to cut or copy an item but don't wish to lose the
current contents of the Clipboard, first select the
Scrapbook from the ® menu and then choose Paste to
deposit the contents of the Clipboard into the Scrapbook.
Up to 256 items may be placed in the Scrapbook, so
running out of room shouldn't be a problem.
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To later access the contents of the Scrapbook, select it
from the & menu (or just click on it if it is still visible on the
screen) and the Scrapbook will open up over the desktop
with the last image pasted displayed in the Scrapbook
window. To find a different image, use the scrollbar along
the bottom of the Scrapbook. When the desired image is
displayed, simply choose either Cut or Copy. If an
image in the Scrapbook is no longer needed, you can
delete it by choosing either Cut or Clear when the

image is displayed in the window.




The Scrapbook can be used to store both text and
graphics; the word PICT which appears in the lower right-
hand corner of the window indicates that the currently
displayed item is a picture. The numbers with the slash
between them in the lower left-hand corner of the
Scrapbook window indicate which item is now being
displayed and how many total items are in the
Scrapbook, respectively.

- Pasting a Marquee-Selected Image

There are two ways to paste a marquee-selected image.
By simply choosing Paste, or pressing the 3 and "V"
keys, the selected image will be pasted in the center of
the active window, on top of anything that's already there,
still enclosed in a marquee so that it may be moved about
in the window. The pasted image won't disturb the
image underneath, as selected images "float "on top of
the picture until you click elsewhere and de-select them.

If you open a new marquee and then select Paste, the
image will shrink or stretch to fit inside the new marquee.

+ Pasting Text

When text from another application or the Scrapbook is
pasted into the active window, the text appearsin a
selection marquee. The text selection may be dragged
like any other marquee selection. Holding down the
key while dragging the selection marquee will cause the
marquee to resize, and the text will be rearranged to fit
the new selection rectangle.

+ Pasting a Lasso-Selected Image

When you are dealing with a lasso-selected image,
choosing Paste, or pressing the 3 and "V" keys, will
cause the image to be pasted in the center of the active
window, still enclosed in the lasso so that it may be
manipulated in it's new location.
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Opening a marquee and then pasting a lasso-selected
image into the marquee will cause the image to be
shrunken or stretched to fit the marquee.
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« Making Copies of Selections

You can make a copy of both marquee- and lasso-
selected images by holding down the Option key when
you click and drag the selection. The original image
remains in place, while a copy is dragged with the
mouse. Copies can then be placed any number of times
by clicking inside the selected area (with the Option key
held down) to 'drop' a copy, dragging it to the next
location, clicking inside the selected area, and so on.

By holding down both the Option and Shift keys before
you click and drag the selected image, you can position
the copy or copies on an exact horizontal or vertical line
from the original.
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It's also possible to make a trail of copies by holding

down both the Option and 3 keys when you click on a
selection; when the selected image is then dragged, a
series of identical images will be left along the path of the
mouse.
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Leave a trail of copies by
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Command keys while dragging.
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The number of copies laid down, and the space between
them, will vary according to the speed of the mouse and
the current border width. The border width on the tool
palette determines the minimum spacing between copies.

By adding the Shift key to the Option and 3 key
sequence, you can constrain the copies and lay them on
an exact vertical or horizontal line.

« Manipulating Marquee Selections

Holding down the 3 key while dragging out a marquee
selection box causes the rectangle to shrink to the
minimum size needed to enclose the black pixels in the
iImage. This feature is particularly useful when selecting
images that wili be manipulated with any of the Free
Rotate, Skew, Distort and Perspective commands.
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When using the marquee, you can resize the selected

image by holding down the 3 key, placing the cursor just
inside the marquee border, holding down the mouse
button, and dragging. Dragging the cursor.toward the
center of the marquee causes the marquee and the
image to shrink; dragging the pointer away from the
center causes both to stretch.

While stretching or shrinking a marquee selection, you
can avoid changing it's proportions it by simultaneously
holding down the 3 and Shift keys. The image will thus

retain it's original proportions, but will change in absolute
size.

+ Marquee Selections With the Option Key

Holding down the Option key while dragging out a
selection rectangle allows you to perform a pair of useful
techniques.

First, holding down the Option key will allow you to drag
out marquee selections bigger than window size. When
the selection rectangle gets to the edge of the window,

the window will scroll down the page with the rectangle.



By starting your selection in a corner of the page, you can
select the entire page in this fashion. Triple-clicking on
the marquee icon is a shortcut for selecting the entire

page.

Second, holding down the Option key while dragging out
a marquee selection of any size will allow you to then
drag that selection to a new position anywhere on the
page. Holding down the Option key while pasting a
marquee selection will also allow you to drag the
selection anywhere on the page. A marquee selection
made and/or pasted without the Option key can only be
dragged to a new position within the active window.

However, when making marquee selections with the
Option key it is important to note that there are several
functions that can't be performed on these selections:
single copies or trails of multiple copies; stretching or
shrinking the selection; the Trace Edges, Rotate, Free
Rotate, Skew, Distort, or Perspective commands.

Selections made with the Option key held down will
appear slightly different. The "crawling ants™ which border
the selection are noticably smaller and slower than those
surrounding normal marquee selections.
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Other Commands

The following are commands from the Edit and Goodies
menus which can be used on selected images.

Invert - Reverses the color of all pixels in a selected
area, changing all black bits to white, and all white bits to
black. The image in a lasso or marquee selection is
completely inverted.
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Fill - Fills a selected area with the current pattern.
Marquee and lasso selections are completely filled with

the current pattern. Holding down the 3 key while using

the Fill command on selections allows underlying images
to show through.
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Trace Edges - Traces the edges of an image in a
marquee selection. The tracing outline is one pixel wide.

Trace Edges can also be used by pressing the 3 and "E"
keys simultaneously. Keeping these keys held down will
rapidly trace multiple edges. Holding down the Shift key
while using the Trace Edges command produces a
shadow around the image rather than a traced edge.

Trace Edges
used once.
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Flip Horizontal - This command flips marquee
selections horizontally, with the left side of the image
becoming the right, and the right side becoming the left.

Flip Horizontal
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Flip Vertical - Flips marquee selections vertically,
making the top of the selected image the bottom, and vice-
versa.
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Rotate - Rotates marquee selections 90 degrees
clockwise.
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« Special Effects

The following four commands for manipulating marquee
selections all operate in a similar way. Selecting one of
these commands from the Edit menu causes the current
marquee to grow handles - small boxes which can be
grabbed and dragged - at the four corners of the selection
rectangle. Clicking and dragging a handle causes the
chosen command to operate on the selected image, with
the distance the handle is dragged controlling the
magnitude of the effect. Clicking outside the marquee
selection and it's handles will deactivate the selection
and drop the manipulated image onto the painting.
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Free Rotate - allows you to rotate marquee selections
by 1 degree increments. If you rotate a selection and find
that all the handles have moved outside the window (and
are therefore unreachable), choose Undo from the Edit
menu and perform the rotation again.
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Skew - allows you to slant the marquee selected image
in either horizontal or vertical directions. The Skew
command forces the sides of the selection marquee to
remain parallel.
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Distort - allows you to arbitrarily change the shape of the
selection box, and hence the shape of the image it
encloses. When a handle is selected and dragged, only
that corner moves, and the image is 'mapped' into the
new shape.
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Perspective - allows you to produce pseudo 3-D effects
by selectively scaling a selection. Clicking and dragging
one of the handles causes that corner and it's parallel
corner to move in opposite directions. The selected
image is compressed or expanded to fit the new shape.
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A useful technique when making a marquee selection
that will be manipulated with the Free Rotate, Skew,

Distort, or Perspective commands: hold down the 3 key
while making the selection. This causes the rectangle to
shrink to the minimum size which will enclose the
selection, enabling you to manipulate only the desired
image with no superflous white space.

Grid - Although the Grid command does not effect the
selected image, it is very useful when dragging selections
around the active window. The grid is an invisible
drawing aide which allows you to positon objects at exact
distances within your painting. Choosing Grid, or
pressing the # and "G" keys, causes the marquee
selection, lasso selection, text tool, line tool and all shape
tools to move in eight pixel increments, enabling you to
accurately line up images in columns and rows.
Choosing Grid before moving selected images around
the screen keeps selected patterns exactly aligned. Itis
also a valuable aid for adding new text to existing text.

Details on other means of manipulating selected images
can be found in the Special Keys section of the Advanced
Capabilities chapter.



Advanced | Brush Mirrors

Capabilities
and Shortcuts To paint symmetrical shapes, choose Brush Mirrors
from the Goodies menu. The mirrors only affect the
paintbrush tool.

The four possible mirrors are each represented by a line.
The mirrors may be used one at a time or in combination.
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If you choose one mirror, any brushstroke you make in
the painting window will be doubled, with one
brushstroke being drawn in the exact screen location of
the brush and another drawn directly opposite, in the
mirrored direction you chose. Choosing two mirrors will
quadruple the brushstroke, and so forth. To turn off
mirroring, choose Brush Mirrors and then click in the
None button.

Edit Brush Shape

FullPaint offers 32 brush shapes to choose from, but if
that's not enough, you have the capability to create your
own.

Holding down the 3 key while choosing Brush Shapes
from the Goodies menu or while double-clicking on the
paintbrush icon in the tool palette brings up the Edit
Brush Shape window and allows you to alter the current
brush shape.

Holding down the 3 key while clicking on a brush in the
Brush Shapes window will also bring up the Edit Brush
Shape window. You can then edit more than one brush
by repeatedly clicking on different brushes with the 3 key
held down.
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On the left side of the Edit Brush Shape window is a
FatBits view of the selected brush shape for editing. Click
on or drag through the dots in the FatBits view in order to
change the brush shape. The changes you make there
will appear in the upper right area of the window, where a
full view of both the brush shape and the kind of stroke it
will paint are displayed.

After you have made changes to the brush shape, click in
the OK button to save those changes. If you don't wish to
save the changes, click in the Cancel button. When you

save changes to a brush shape, you eliminate the

original brush shape that was in that location in the Brush

Shapes window.

The new brush shape that you create will be stored with
the FullPaint program, making it accessible from any
document. However, if the disk is locked (if the small
colored tab in the upper right corner of the disk is in the
open position), then the new shape will only be available
until you quit the program. You can also bring back the
original brush shape at any time by clicking in the
Original button; this redraws the original brush shape
and eliminates the shape you created.

You can make any area of the screen into a brush shape
by first bringing up the Edit Brush Shape window, then
clicking on the part of the screen which you wish to make
into a brush. This action imports a 16 pixel by 16 pixel
section from the area in which you clicked to the Edit
Brush Shape window. Any section of the screen may be
imported in this fashion.
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Edit Pattern

It's possible to create new patterns by altering existing
ones. To create a new pattern, click on the pattern you
wish to change, then choose Edit Pattern from the
Goodies menu. As a shortcut, you can simply double-
click on the pattern to be edited.
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The left display is a FatBits view of the pattern being
edited. Click on or drag through the dots in the left
display in order to change the pattern. The changes you
make will appear simultaneously in the right display.

You can use any pattern visible on the screen by first
bringing up the Edit Pattern window, then clicking on
the part of the screen which you wish to make into a
stored pattern. This action imports an 8 pixel by 8 pixel
section from the area in which you clicked to the Edit
Pattern window. Any section of the screen may be
imported in this fashion. Note that the section imported
will be aligned on eight pixel boundaries. If you want to
grab an arbitrarily aligned section of the screen, hold

down the 3 key while clicking.

Clicking OK will replace the original pattern with the one
you have created. Clicking Cancel will keep the original
pattern. Patterns you create are saved only with the
particular document that is active at the time.

——
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ial K
* The Option Key

» Holding down the Option key while using the straight
line tool and the shape tools draws them in the current
pattern. (The line and shape tools are normally drawn in
black.)

+ Holding down the Option key while using the pencil
changes it into the hand tool. This operation may also be
performed in FatBits mode.

* Holding down the Option key while dragging a
marquee selection or lasso selection creates a single
copy of the selected image.

* Holding down the Option key while making a marquee
selection allows the selection to be larger than the
window, and to be dragged anywhere on the page.

* Holding down the Option key while clicking on the
palettes allows you to drag the palette from that point,
rather than just from the edges.

* Holding down the Option key while making a lasso
selection allows you to select white areas of the
document. This tells the lasso tool not to shrink the
selection outline down to an image's black pixel
boundary.

« The ¥ Key

» Holding down the 8 key while dragging the cursor
away from the center of a marquee selection stretches the
selected image. Holding down the 3 key while dragging
the cursor towards the center of a marquee selecton
shrinks the selected image.
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+ Holding down the 3 key while selecting something with
the marquee causes the rectangle to shrink to the
minimum size which will enclose the image.

+ Holding down the 3 key while clicking in the active
window with the pencil tool allows you to enter and leave
FatBits at the exact location of the pencil.

* Holding down the 3 key while filling, painting , or
typing over an existing image allows the underlying
image to show through.

+ Holding down the # key in conjunction with the < >
keys changes the font size.

» Holding down the 3 key while double-clicking on the
paintbrush tool brings up the Edit Brush Shape window.

» Holding down the 3 key while clicking on a brush
shape in the Brush Shape window brings up the Edit
Brush Shape window.

» Holding down the 3 key while selecting an area of the
screen to be edited in the Edit Pattern window allows you
to grab an arbitrarily aligned section of the screen.

» The Shift Key

+ Holding down the Shift key in conjunction with the
Trace Edges command causes a shadowed outline to be
drawn.

+ Holding down the Shift key in conjunction with any of
several tools constrains drawing or movement of the
image to exact vertical or horizontal (the line tool can also
move on an exact 45 degree angle).

]



« Option and

« Holding down both the Option and 3 keys while
dragging the marquee or lasso selection makes multiple
copies of the selected image. The current line width
determines the minimum space between copies.

3 and Shift

+ Holding down the 3 and Shift keys in conjunction with
the < > keys changes the font.

- Holding down the 38 and Shift keys while dragging a
marquee selection causes the selection to be stretched
but kept in proportion.

| hort

Double-clicking with the lasso tool on an image that is
completely bordered selects the image.

Double-clicking on the rulers or on the MouseSpot
display brings up a dialog box asking you for measuring
unit preferences.

« Double-Clicking on Icons

Lasso-selects the entire active window.

Marquee-selects the entire active window.

Displays the ShowPages window.



Displays the Brush Shapes window.

Presents a FatBits view of the current painting area.

Erases the entire active window.

Displays the Edit Pattern window.

« Triple-Click Shortcut

ey
] I

Marquee-selects the entire document.

e

* Keyboard Shortcuts

Will Undo the last event.

|Backspace| Will erase the selected image.

Constesin] || J[_1L JCICICICIC IO ]
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For on-screen reference, choose Help from the % menu,

or hold down the 8 and "H" keys simultaneously, or click
on the "?" located on the right side of all document title
pars.

« Tool Palette Reference

Selects a non-rectangular image.

Selects a rectangular image, including any background.
Moves the view in the active window over the document
so that other portions of the 8 x 10 drawing area may be
viewed and edited.

Allows text to be entered from the keyboard.

Fills an enclosed or outlined area with the current pattern.
Spraypaints the current pattern.

Paints the current pattern. Brush shapes may be
changed via the Brush Shapes command from the
Goodies menu.

Draws a thin line.

Draws straight lines. The line width may be changed via
the border width control.

Erases images. Double-clicking on the icon erases the
entire active window.

Draws a hollow rectangle. The border width may be
changed via the border width control.

Draws a filled rectangle. The border width may be
changed via the border width control.
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Draws a hollow rectangle with rounded corners. The
border width may be changed via the border width
control.

Draws a filled rectangle with rounded corners. The
border width may be changed via the border width
control.

Draws a hollow oval. The border width may be changed
via the border width control.

Draws a filled oval. The border width may be changed
via the border width control.

Draws a freehand line. The border width may be
changed via the border width control.

Draws a freehand filled shape. FullPaint automatically
connects the ends of the freehand line and fills the
constructed shape with the current pattern. The border
width may be changed via the border width control.

Draws a hollow polygon. The beginning and ending
points of each side of the shape are set by single clicks of
the mouse, until the end of the last side, which is set with
a double-click, a single click on the start point, or a click
outside the window. The border width may be changed
via the border width control.

Draws a filled polygon. Click once to turn a corner on a
drawing. Double-click or click again at the beginning
point in order to end a drawing and have it filled with the
current pattern. The border width may be changed via
the border width control.
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The checkmark indicates the current line/border width.
The current width affects the appearance of the straight
line tool and all shape tools.

Presents a full-screen view.

Presents a full-screen view with a menu bar along the top.

Presents a windowed view similar to that found in other
Macintosh applications.

Clicking on a pattern selects it as the current pattern.

« Keystroke Options
¥ - Atoggles the menu bar while in full-screen mode.

3# - B selects the Bold command from the Style menu.

# - C copies the selected image and places it on the
clipboard.

# - E implements the Trace Edges command from the
Goodies menu.

# - F enters you into FatBits mode.
# - G selects the Grid command from the Goodies menu.
3 - H brings up an online Help screen.

# - | selects the ltalic command from the Style menu.



# - L selects the Align Left command from the Style
menu.

# - M selects the Align Middle command from the Style
menu.

# - O selects the Outline command from the Style menu.
# - P selects the Plain command from the Style menu.

¥ - R selects the Align Right command from the Style
menu.

# - S selects the Shadow command from the Style menu.
3 - T toggles the tool and pattern palettes.

# - U selects the Underline command from the Style
menu.

¥ -V pastes whatever item is on the clipboard into the
active window.

3 - W cleans up the palettes, returning them to their initial
default positions.

¥ - X cuts out the selected image and places it on the
clipboard.

# - Z will undo the last event performed.



Error Messages
and Remedies

There are two kinds of error messages you may
encounter. One set are based on memory space
problems and the other are based on disk problems.

Memory error messages may appear at a number of
different times. When you are trying to open or create a
new document, a message may appear telling you there
is not enough memory to open another document. If you
are running under Switcher, you may have only allocated
enough memory for one, two, or three documents. Or
there may be too many desk accesories open to fit
another document. Close all the open desk accesories
and try again. If this doesn't work, save all your open
documents, quit from the FullPaint program, and then try
running it again. This normally resolves any memory
problems.

Memory problems can also appear when you are trying to
open too many desk accesories at once. If this happens,
close some of the open ones before trying to open any
new ones.

Memory problems can also appear when you are trying to
cut, copy, or paste a very large or complex image. If this
happens, try closing one of the open documents and
repeating the operation.

From time to time FullPaint may have trouble saving
(Save, Save As...) or opening (Open...) documents.
When this happens a disk error window will appear. In
the lower left corner of the window is a message telling
you the type of error that occured. Some errors are
merely annoyances, some serious but recoverable, and
some catastrophic. The errors below are the ones which
you can recover from. If you get an error message which
is not in this list, or you don't understand the procedure
listed below, you may want to ask your local Apple dealer
for assistance.



86

Already Open for Writing - The document is stuck
open. This can occur if you are trying to save to a
document that was being written to when the Macintosh
was unplugged or reset. Use Save As... and save your
work to a new file.

Can't Find That Drive - A cable may have become
loose. Check them, but first save a copy of your open
documents on a drive that is still available and turn off the
Macintosh.

Can't Find Volume - A hard disk volume can't be

located. Check the instructions that came with your hard
disk.

Can't Get Write Permission - The document is
marked as not changeable. Make a copy of it in the finder
and try again.

Can't Write to File - Try a Save As... with a different
name.

Disk /O Error - An unhappy event. The disk may be
damaged. Save the document on another disk and
Reboot and try again. If unsuccestul, try opening the
program from another disk and then accessing the bad
disk's files from the Open window.

Disk is Full - There is no space left on the current disk.
Save the file on another disk.

Disk is Locked -The disk can't be altered until it is
unlocked. To access the disk, go to the finder, select it on
the desktop, choose Get Info from the Edit menu, and
click in the Locked checkbox.
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Disk is Write Protected - If you wish to write to the
disk, eject the disk (command-shift-1 for the internal drive;
command-shift-2 for the external) and slip the small
colored tab in the upper right corner of the disk into the
closed position.

Early End of File - The FullPaint document is not
complete on the disk. Something bad probably
happened while it was being saved the last time. You
can't do much about this so either ask a hacker friend for
help or just throw the file away from the finder.

File Directory is Full - There are too many files on the
disk. Save the file to another disk. Note that this error
may occur even when there is room left on the disk.

File is Locked - that file can't be altered until it is
unlocked. To access the file, select it on the desktop,
choose Get Info from the Edit menu, and click in the
Locked checkbox.
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A
Arranging Documents - 39, 40, 41
AutoScroll - 32, 33

B

Backspace Key - 58

Big Selections - 63, 64

Borders - 22

Brush Mirrors - 73

Brush Shapes
changing the current shape - 8,17, 18, 30
editing the current shape - 74, 75

C
Centimeter Units - 47, 48
Changing the Brush Shape - 8, 17, 18, 30, 74, 75
Changing the Current Pattern- 8, 9, 19, 76
Clean Up - 40
Clear - 31, 58, 59
Clipboard - 58
Close Box - 11
Closing a Document - 11
Command Key Equivalents
explained - 9, 10
listed - 83, 84
Command Key Shortcuts - 77, 78, 79
Constraining Movement - 17, 18, 20, 22, 44, 46, 61
Copy Command - 53, 54
Copying a Document - 15
Current Pattern - See Patterns
Custom Font Sizes - 28
Cut - 58, 59

D

Default Settings - 37, 42
Desk Accessories - 37
Distort - 71, 72
Double-Clicking - 6, 79, 80



Drawing - 19, 20, 21, 22
Duplicate - 15

e

Edit Brush Shape - 74, 75

Edit Pattern - 76

Eject- 15

Empty Folder - 14

Eraser 9, 30

Erasing Techniques - 29, 30, 31
Error Messages - 85

F

FatBits - 31

File Menu -6

Fill Command - 66
Filling Outlined Areas - 23, 24, 25, 66
Finder - 5, 14, 52

Flip Horizontal - 68
Flip Vertical - 68

Font Menu - 27
FontSize Menu - 27
Free Rotate - 70, 72
Freehand Drawing - 21
Full Screen - 35, 36

G

Getting Started - 5, 6, 7
Grid - 25, 72

Grow Box - 37

H

Hand Tool - 33, 46

Handles on Selections - 69, 70, 71
Help - 2, 81

Hide Tools - 42

I
ImageWriter - 50, 51
Inch Units - 47, 48
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Insertion Point for Text - 25
Invert - 65

K

Keystroke Options
explained - 9, 10
listed - 83, 84

L

LaserWriter - 51, 52

Lasso Tool - 56, 57, 58, 60, 61
LazerPrint - 52

Line Tool - See Straight Line Tool
Line Widths - 21, 22

M
Marquee Tool - 55, 56, 57, 60, 61
Measuring Units - 47,48 -
Menu Bar - 36
Menus - 9
Mirrors - See Brush Mirrors
Mouse Crawl - 49
MouseSpot - 48
Moving Around the Document
autoscroll - 32, 33
hand tool - 33, 46
scrollbars - 33, 46
Multiple Documents - 38

N

New Document-6, 7, 12
New Folder - 14

O
Opening a New Document - 6, 7, 12

Opening an Existing Document - 12
Opening Multiple Documents - 38
Opening the Program - 5, 6, 7
Option Key Shortcuts - 77, 79
Ovals - 21



P
Page Position - 47, 48
Paintbrush - 8, 17
Paintcan - 23, 24, 25
Palettes
using-7,8,9,19
moving and hiding - 42
Paste - 58, 60
Patterns
changing - 8,9, 19
drawing in - 20, 22
editing - 76
Pencil - 7, 19
Perspective - 71, 72
Pica Units - 47, 48
Pixels - 17, 47, 48, 49
Polygons - 22
Pop-up Rulers - 47
Preferences Dialog Box - 28, 32, 49
Printing
draft mode - 50, 51, 52
final mode - 50, 51, 52
from the Finder - 53
ImageWriter - 50, 51
LaserWriter - 51, 52
reduced - 50, 51, 52
screen shots - 53
selections - 50, 51, 52

Q
Quitting the Program - 13

R
Rearranging Documents - 39, 40, 41
Rectangles
round cornered - 21
square cornered - 21
Reference - 81, 82, 83, 84
Revert - 29
Rotate - 69, 75
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Round Cornered Rectangles - 21
Ruler Units - 47, 48
Rulers - 47

S
Sample Paintings - 14
Save As - 13
Saving a Document - 10, 11
Scrapbook - 59, 60
Scrollbars - 33, 46
Select All - 38
Selecting With the Lasso - 56, 57, 58, 60, 61
Selecting With the Marquee - 55, 56, 57, 60, 61
Selections
cutting, copying, and pasting - 58, 59, 60
multiple copies of - 61, 62
larger than window size - 63, 64
making - 55, 56, 57
manipulating - 65, 66, 67, 68, 69, 70, 71, 72
minimum size - 62, 72
Shape Tools - 21, 22
Shift Key Constraint - 17, 18, 20, 22, 44, 46, 61
Shift Key Shortcuts - 78, 79
Shortcuts - 77, 78, 79, 80
Show Tools - 42
ShowPages
browsing - 46
erasing with - 31
moving the active viewing area - 43, 44, 45
Shrinking Selections - 61, 63
Shut Down - 15
Skew - 70, 72
Special Effects - 69, 70, 71, 72
Spraypaint Tool -9, 18
Square Cornered Rectangles - 21
Stack Up - 41
Straight Line Tool - 20
Stretching Selections - 61, 63
Style Menu - 27
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Switcher-3

T
Text

changing - 25, 27, 28

menus - 27

opposite color - 26

pasting - 60

tips - 29

transparent - 26

wrapping - 25
Tool Palette

using-7,8

moving and hiding - 42
Trace Edges - 67
Transparent Painting - 17, 18, 19, 22, 26
Triple-Clicking - 74

U
Undo
erasing with - 29
examples of - 24, 31
Units - 47, 48

Vv
Variable Font Sizes - 28
ViewBox - 32

W
Windows
dragging to a new location - 41
using the grow box - 37
sizes - 35, 36, 37
tools - 35, 36, 37
Windows Menu - 39
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tools in the form of innovative programs. This product is just one example of our commitment. For
more information, contact: Ann Arbor Softworks, 308': S. State, Ann Arbor, M1 48104 (313)996-3838.

LIMITED WARRANTY

THIS PROGRAM, INSTRUCTION MANUAL. AND REFERENCE MATERIALS ARE SOLD "AS 15" WITHOUT WARRANTY AS TO THEIR PERFORMANCE,
MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THIS PROGRAM 15

ASSUMED BY THE BUYER

HOWEVER, TO THE ORIGINAL PURCHASER ONLY, THE PUBLISHER WARRANTS THE MAGNETIC DISKETTE ON WHICH THE PROGRAM 15 RECORDED TO BE
FREE FROM DEFECTS IN MATERIALS AND FAULTY WORKMAMNSHIP UNDER NORMAL USE FOR A PERIOD OF NINETY DAYS FROM THE DATE OF PURCHASE.
IF DURING THIS NINETY-DAY PERIOD THE DISKETTE SHOULD BECOME DEFECTIVE. IT MAY BE RETURNED TO THE PUBLISHER FOR A REFLACEMENT
WITHOUT CHARGE, PROVIDED YOU HAVE PREVIOUSLY SENT IN YOUR LIMITED WARRANTY REGISTRATION CARD TO THE PUBLISHER OR SEND PROOF OF
PURCHASE OF THE PROGRAM,

YOUR SOLE AND EXCLUSIVE REMEDY IN THE EVENT OF ADEFECTIS EXPRESSLY LIMITED TO REPLACEMENT OF THE DISKETTE AS PROVIDED s
ABOVE. IF FAILURE OF A DISKETTE HAS RESULTED FROM ACCIDENT OR ABUSE THE PUBLISHER SHALL HAVE NO RESPONSIBILITY TO ‘=
REPLACE THE DISKETTE UNDER THE TERMS OF THIS LIMITED WARRANTY

ANY IMPLIED WARRANTIES RELATING TO THE DISKETTE, INCLUDING ANY IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. ARE LIMITED TO A PERIOD OF NINETY DAYS FROM DATE OF PURCHASE PUBLISHER SHALL NOT BE LIABLE FOR
INDIRECT, SPECIAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM THE USE OF THIS PRODUCT. SOME STATES DO NOT ALLOW THE
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS MIGHT NOT APPLY TO YOU THIS
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND ¥OU MAY ALSD HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE.




